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1 GLOSSARY AND LIST OF TBC & TBD PARAMETERS

CNES Centre National d'Etudes Spatiales
XML eXtended Markup Language

List of TBC parameters:

List of TBD parameters:
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2 GENERAL
2.1 REFERENCE DOCUMENTS
DR1 Producer-Archive Interface Specification
CCSDS-651.1.1-R-1
DR2 XML formatted data unit (XFDU) structure and construction rules

CCSDS 661.0-B-1

2.2 APPLICABLE DOCUMENTS
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3 INTRODUCTION

This document explains how to install and use the CNES CCSDS PAIS prototype.
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4 ENVIRONMENT

The minimum configuration recommended for installation of the software is as follows:
PC operating system: Windows XP sp2 or higher
Memory: at least 512MB.
Java run time: JRE 1.6 or higher

4.1 SOFTWARE AND TEST CASE TREE STRUCTURE

All of the files required are grouped together in zip packages with the following names:

pais-<version>.exe (self-extracting executable for Windows), or pais-<version>.zip (zip archive for
Mac),

pais-data-<version>.zip
The first package contains the prototype and the libraries needed to run the program.
The second package contains example cases with their description and the required data files for the database.

The software installs under a conventional directory, such as C:\Program files\PAIS:

Mom .
conf
defaultProject
images
lib
|| Licence_CeCILL V21-en.txt
|| Licence_CeCILL V21-fr.bdt
1= logdjxml
5| pais.bat
|| pais.jar
|| pais.properties

|| pais.sh

in which pais.jar is the software, lib is the directory of required libraries, pais.properties is the configuration file for
the software and directories in particular, log4j.xml is the log4j configuration file and pais.bat (or pais.sh) is the
program launcher.
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Examples and the associated files can be deployed in a dedicated space, such as C:\PAIS_DATA:

-~

4 [ PAIS_DATA o MNom Modifié le Type
» || database . . o _ . o
. Manifest_cdpp-wind 18/03/201517:3 Dossier de fichiers
4 | examples . o _ . o
- . Manifest_COROT-MNO 18/03/201517:3 Dossier de fichiers
4 | projects i R . i o
- : = . Manifest_ESA_ERS_AMI_SAR 18,/03/201517:31 Dossier de fichiers
» ) Manifest_cdpp-wind . o _ . o
) . Manifest_ESA_ERS_AMI_SAR_det 18/03/201517:3 Dossier de fichiers
» . Manifest_CORQT-MNO . o _ . o
) . Manifest_ISEE 18/03/201517:3 Dossier de fichiers
» . Manifest_ESA_ERS AMI_SAR . o . o
. . Manifest_POLDER 18/03/201517:31 Dossier de fichiers
» . Manifest_ESA_ERS_AMI_SAR_det . I o
. | exp_cdpp-wind.epp 18/03/201517:18 Fichier EPP
» 1 Manifest_ISEE o _ o
) | exp_COROT-NO.epp 18/03/201517:18 Fichier EPP
» . Manifest_POLDER o o o
| exp_digitized_newspapers_1.epp 18/03/201517:18 Fichier EPP
|| exp_ESA_ERS_AMI SAR.epp 18/03/201517:18 Fichier EPP
|| exp_ESA_ERS_AMI_SAR_det.epp 18/03/201517:18 Fichier EPP

exp_MNASA_ESA_CMES_Test Data_Exchan..  18/03/201517:18 Fichier EPP
exp_MNASA_ESA_CMES_Test Data_Exchan..  18/03/201517:18 Fichier EPP
exp_POLDER.epp 18/03/201517:18 Fichier EPP
exp_POLDER-Multi-L1GB.epp 18/03/201517:18 Fichier EPP

The “database” directory contains the tables and data managed by the “Apache Derby” database.
The “examples/projects/” contains the example files:

> “exp_*.epp” files which are exported from example projects.

» “Manifests_*” directories which contain the SIP manifests of exported projects.
To install the example projects, refer to the “6. Quick start-up” section.

Once deployed, the project appears as follows:

Dossiers » | MNom = | Tooo | Tvpe |
El&] oL 0ER »| DDconf Dossier de fichiers

3 corf [ descriptars Dossier de fichiers

() descriptors ([Dloas Dossier de Fichiers

) logs [Z)xFdu Dossier de Fichiers

=15 wfdu raak, ol 6 Ko Document =ML

I) archives
5 irevalid
I5) reception

The “conf” directory contains the model definition files (Xml Schema).
The “descriptors” directory contains the project description files.

The “logs” directory holds the processing log for this project

The “xfdu” directory is made up of 3 sub-directories:

e “archives” which contains the xfdu files received.
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e ‘“invalid” which contains the incorrect xfdu files received.
e ‘“reception” which contains the xfdu files to be processed.

Note: For Mac, copy the zip files into /Applications. The program launcher is called pais.sh.

4.2 SOFTWARE INSTALLATION

» For Windows:
From the Windows explorer, execute (double-click) the pais-<version>.exe file.
Select the software installation directory and then click “start”.

Deploy the example file pais-<version>-data.zip which contains the manifest files, project exports and some files to
manage the database, under “C:\PAIS_DATA” in our example:

-~

4 | J PAIS DATA i Nom Modifié le Type
» Ju database . . e 4 . _
. Manifest_cdpp-wind 18/03/201517:31 Dossier de fichiers
4 | examples . R, . _—
; . Manifest_COROT-NO 18/03/201517:31 Dossier de fichiers
4 | projects i . . . i o
= . Manifest_ESA_ERS_AMI_SAR 18/03/201517:31 Dossier de fichiers
» ) Manifest_cdpp-wind . e e 1 . _—
. Manifest_ESA_ERS_AMI_SAFR_det 18/03/201517:31 Dossier de fichiers
» . Manifest_CORQT-MNO . A . _—
. Manifest_ISEE 18/03/201517:31 Dossier de fichiers
| Manifest_ESA_ERS_AMI_SAR . o . o
. Manifest_ POLDER 18/03/201517:31 Dossier de fichiers
» J. Manifest_ESA_ERS_AMI_SAR_det . e 4 -
. | exp_cdpp-wind.epp 18/03/201517:18 Fichier EPP
» 1 Manifest_ISEE o _ o
. || exp_COROT-N0.epp 18/03/201517:18 Fichier EPP
» . Manifest_POLDER o A L
| exp_digitized_newspapers_1.epp 18/03/201517:18 Fichier EPP
|| exp_ESA_ERS_AMI SAR.epp 18/03,/201517:18 Fichier EPP
|| exp_ESA_ERS_AMI_SAR_det.epp 18/03/201517:18 Fichier EPP
|| exp_MNASA_ESA CMES Test Data_Exchan... 18/03/201517:18 Fichier EPP
|| exp_MNASA_ESA CMES Test Data_Exchan.. 18/03/201517:18 Fichier EPP
|| exp_POLDER.epp 18/03/201517:18 Fichier EPP
| exp_POLDER-Multi-L1GB.epp 18/03/201517:18 Fichier EPP

Issue the “pais.properties” file (default location is “C:\Program files\PAIS\Vx.y”, vx.y is the version number) to
update the “pais.dataroot.dir variable with the directory corresponding to the installation of PAIS_DATA, and enter
the “pais.proxy” parameter if necessary.

= For Mac:
Copy the zip files into /Applications.
Issue the “pais.properties” file (default location “/Applications/PAIS/Vx.y”, vx.y is the version number”) to update the

“pais.dataroot.dir” variable with the directory corresponding to the installation of PAIS_DATA, and enter the
“pais.proxy” parameter if necessary.
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4.3 DATABASE INSTALLATION

Since the version 2.13 of the CNES CCSDS PAIS prototype, the database is managed by an “Apache Derby”
relational database embedded by the application. No specific installation is needed, and administrator rights are not
required.

4.4 DATABASE VISUALISATION

Note: This section is an administrative one, and doesn’t concern a common usage of PAIS. The next installation IS
NOT NEEDED to run the application.

PAIS use a Derby database. To show database content, you can use a client like ‘SQuirreL SQL’. After the
installation of this tool (http://squirrel-sql.sourceforge.net/), you need to follow these steps:

First, you need to download and unzip the lib distribution of ‘Apache Derby’
(http://db.apache.org/derby/derby downloads.html),

Then, you need to define an ‘Apache Derby Embedded’ driver: Click on the tab ‘Drivers’ on the left side select
‘Apache Derby Embedded’ in the list and double click on it. On the driver configuration dialog, select the tab ‘Extra
Class Path’, click on ‘Add’ button and select all ‘jar’ files included in the lib folder of your ‘Apache Derby’ distribution
installed during the previous step,

To finish, you need to define a new alias to connect to the PAIS database: Click i the tab ‘Aliases’ on the left side,
click on the tool button with the blue icon ‘+’ to create a new alias. In the alias definition dialog box: define a name
for your alias (for example ‘PAIS’), select the ‘Apache Derby Embedded’ driver, and define the URL with:
‘idb:derby:YOUR_PAIS_DATA_FOLDER\database\PAIS’ (Replace ‘'YOUR_PAIS_DATA_FOLDER'’ by the path of
your ‘PAIS_DATA'’ folder).

Now, you can open the connection dialog by double clicking on your alias, and connect to your database by clicking
on the ‘Connect’ button.

19/03/15 18:03
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5 GETTING STARTED

5.1 STARTING UP THE SOFTWARE

=  For Windows

From the Windows explorer, execute (double-click) the “pais.bat” launcher (default location: “C:\Program
files\PAIS\Vx.y”, vx.y is the version number).

=  [For Mac

From the explorer, execute (double-click) the “pais.sh” launcher (default location: “/Applications/PAIS/VX.y”, vx.y is
the version number).

Enter a login / password; then click on “OK”. In the case of the prototype, no account is created and any username
and password can be used.

x

Login
3 Password required,

Credentials* \".

Username 'J:‘| |

Passward IJJ |

Cancel |

To facilitate quick start-up with the software, example projects are provided in the PAIS_DATA directory. These
exported projects are in the form files with the extension “epp” for “Export Pais Projet”. For each project, a
“Manifest_*”" directory with example SIPs are provided. For quick start-up, see the 6. Quick start-up paragraph.

5.2 IMPORTING AND EXPORTING A PROJECT

5.2.1 Importing a project

Importing a previously exported project is only possible if the project is no longer in the “Project manager” space;
otherwise, it needs to be deleted or renamed before being imported (check that other tabs are closed).

Open the “File” menu and click on “Import ...”. Select an “epp” extension export file in the
“PAIS_DATA/examples/projects” directory, then validate by clicking on the “Import” button.

19/03/15 18:03
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=0l x|
File Edit ‘Window Help
—r x|
L

- Project I'I'IE'lI'IE'";.llEF"'.I Rechercher dans : ’D projecksyz, 10 v] @

H Project manager

----- [ Projects

[C3 Manifest_ISEE

3 Manifest_POLDER,

E| exp_MAasa_ESA_CMES_Test_Data_Exchange_D1.epp
@ exp_MASA_FSA CNES_Test_Data_Fxchange_02.epp
@ exp_POLDER-Mulki-L1GE. epp

B exp POLDER.epp

Mom de Fichier |e::<|:|_PDLDER.epp |

Fichiers du bype : [F‘.ﬁ.IS project (*.epp) v]

[ Import ] [.ﬁ.nnuler ]

5.2.2 Exporting a project

A project can be exported into an “epp” extension file on the “Project manager” page. The project export concerns

only the model files and the descriptors. Select a project and then click on “Export”, either from the contextual menu
(right-click the mouse on the selected element) or the “File” menu.
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PAIS prototype =10l x|

File  Edit ‘Window Help

=

¢+ Project manager ‘\

E Project manager

[=h1_1 Projects

cdpp-wind

WIND CDPP use case

ISEE test case 1

Qpen the project...

Rename. ..

Expott. ..

¥ Delete Supprrner

Properties Alt-Entrée

Test Case 2

5.3 IMPORTING A DESCRIPTOR OR CONSTRAINT FILE

A descriptor can be imported into an existing project and opened via the MOT editor. If this descriptor does not
comply, it is rejected and the errors are logged into the monitor. Imported descriptors must then be associated in
the model.

19/03/15 18:03



AKKA IS SGDS-MI-5230-1330-SI
PAIS Iss.: 02 Date: 06/03/2015
Rev.: 00 Date: 06/03/2015
Reference: SGDS-MI-5230-1330-SI Page: 11

g S )

File Edit Window Help

< Project manager % MOT editor (COROT—ND)\

MOT editor (COROT-NO)

@)= [ [2]e| [m]e]%]a] [m]w] [&[a]a] [ET

FEIEE

u W
o
aw

Switch to transfer mode

Hide/Show association

Insert

Import Descriptor

1 Import Constraint
| . (]
Print
| [
COROT-NO
s 4

To import descriptors, select “Import Descriptor” in the contextual menu and select files in the dialog:

L bl s EREFRRRRRRRRRRRRR——
[P-—

Rechercher dans : [D tch-corot-20150109 '] @

i corot-pais-collection-n0.xml
[El corot-pais-sip-builder-projectaxml
E corot-pais-sip-constraints.xml
=]
=]

i corot-pais-transfer-object-hk.xml

i corot-pais-transfer-object-runxml

Mom de fichier: ‘ "corot-pais-transfer-chject-hkxml” "corot-pais-transfer-object-run.xml"|

Fichiers du type : [PAIS descriptor (*xml] "'I

[ Import ”Annulerl

You have then to associate the exported descriptors to the right nodes by links.

Note: the imported descriptors may have a wrong parentCollection Identifier (this causes no error because what is

19/03/15 18:03
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required for the transfer is the mandatory controls performed on the Transfer Object descriptors). Nevertheless, if
you want to update this Identifier, you have to change the XML files directly in the “descriptors” directory.

To import the constraint file, select the “Import Constraint” in the contextual menu and select files in the dialog:

% " -—— i
% Import constraints ﬂ
- e —————

Rechercher dans: |3 tcfi-corot-20150109 "I @

[E] corot-pais-collection-n0 xml
S corot-pais-sip-builder-project.aml

B corot-pais-sip-constraints.sml
[El corot-pais-transfer-ohject-hkxml
[E] corot-pais-transfer-object-run.xmi

Mom de fichier: |cDrot—pais—sip—cu:nnstraints.xml |

Fichiers du type: ’PAIS constraint file (*xml) ""]
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5.4 CREATING A PROJECT AND SETTING UP THE MOT

5.4.1 Creating the project

Select the “new project” icon on the left in the toolbar (3}), and then enter the project name and description.

Note: The only characters permitted for project names are alphanumeric characters + the following characters: ‘ ’, ‘-

8

File Edt ‘Window Help

19/03/15 18:03



AKKA IS SGDS-MI-5230-1330-SI
PAIS Iss.: 02 Date: 06/03/2015
Rev.: 00 Date: 06/03/2015
Reference: SGDS-MI-5230-1330-SI Page: 14

5.4.2 Renaming the project

Select the project, right-click the mouse (to display the contextual menu) and click on “Rename...”.

Note: The only characters permitted for project names are alphanumeric characters + the following characters: ‘ ,

l, £$1-

PAIS prototype - ||:||5|
File Edit ‘window  Help
-
- Project manager |

! Project manager

E}._. Projects

. A S : Open the praject...

¥ Delete SuppHnner

Properties Alt-Entrée

tesk
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5.4.3 Editing the project

Select the project, right-click the mouse (to display the contextual menu) and click on “Open the project...”.

PAIE protoktype

File Edit ‘Window Help

i

- Project manager |

E Project manager

E}._. Projects

Open the project. ..

Rename...

¥ Delete
Lest

Supprirmer

Ml { TN

19/03/15 18:03
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5.4.4 Creating the descriptors

Two models exist by default: CCSD0015 for the Collections descriptors which are the nodes of the tree, and
CCSDO0014 for the Terminal descriptors (leaves of the tree) which contain the data descriptions.

Select the root descriptor (created by default), double-click or right-click the mouse (to display the contextual menu)
and then click on “Edit”. Enter the node identifier and label, and then select the Collection model (CCSD0015).

We assume that the MOT contains at least one collection of objects to transfer. By default, the name of the root
node is the same as the project name.

Move the graphic descriptor object on the graph and then create a new descriptor by clicking the icon on the left
(I%) in the toolbar. Enter its identifier, its label and its model.

Note: The only characters permitted for descriptor names are alphanumeric characters + the following characters:

‘_’, ‘-‘, ‘$’-

E}rais prototype i [m] B
File  Edit ‘Window  Help

- E

< Project manager © %® MOT editor (test) "'.

TET MOT editor (kest)
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5.4.5 Creating a link between descriptors

Activate the link creation function by clicking the 2™ icon on the left (|:+) in the toolbar. Click on the original

descriptor to select it and then “drag” it to the target descriptor.

Remark: position the cursor in the centre of the object to drag it (a “hand” appears).
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5.4.6 Editing descriptor attributes

Save the project (Fﬁﬂ), select a descriptor, right-click the mouse (to display the contextual menu) and then click on
“Edit descriptor ...”

E}rais prototype i [m] B
File  Edit ‘Window  Help
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- Project manager % MOT editor (test) "'.
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Fill in the fields using the editor. Red-coloured fields indicate that they are not valid (mandatory, incorrect value,

etc.). Once all of the fields are valid, and after saving (Fﬁﬂ) the changes, the descriptor’s status on the graph also
switches to valid.
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PAIS prototype
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5.4.7 Deleting a descriptor

Select a descriptor, right-click the mouse (to display the contextual menu) and click on “Remove...”. The descriptor
is permanently deleted, as are the links attached to the deleted node.

PAIS prototype - | Ellil
File Edit window  Help
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5.4.8 Printing the model

Print the model by clicking on the icon (@) in the bar or right-clicking the mouse (to display the contextual menu)
and then clicking on “Print ...”. The entire model is printed as it is shown on the screen (WYSIWYG mode).
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5.4.9 Hiding / Showing association links

Show links by clicking on the icon (@) in the bar or right-clicking the mouse (to display the contextual menu) and
then clicking on “Hide/show association ...”.

E}rais prototype i [m] B
File  Edit ‘Window  Help
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Hidej'Show association

Insert

Prink

CDOPP WIND use case

All of a node’s associations can be seen via the MOT editor, by leaving the mouse on the node for approximately
1s. A tooltip appears, stating the details of each association.
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5.4.10 Deleting a project

Select a project, right-click the mouse (to display the contextual menu) and click on “Delete”. Deleting the project
results in permanent deletion of the descriptors associated with the project.

_lojx
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54.11 Receiving XFDU files and validating

In order to switch to transfer mode, all MOT descriptors need to have valid status, and the MOT needs to have been
saved. In the current prototype context, at this stage, no further changes should be made to the structure of the
MOT (adding nodes, ID changes, etc.).

To switch to transfer mode, first, open the corresponding project editor (right-click on the name of the project on the
home page), and then click on "Switch to transfer mode".

Completing the description of this part involves creating XFDU files and placing them in the reception directory,
which is not covered in this document.

See section 6.3 of the test case on using this part of the tool.
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6 QUICK START-UP

To illustrate quick start-up, we will use the POLDER project provided as an example.

6.1 IMPORTING THE POLDER PROJECT

Open the “File” menu and click on “Import ...”. Select the “epp” extension project file in the
“PAIS_DATA/examples/project /exp_ POLDER.epp” directory, and then validate by clicking on the “Import” button.
The project created in the Project manager space is in design mode.

PAIS prototype | 4
File Edit ‘window  Help
=il Import the project x|
| I—

- Project I'I'IEIFIEIQEF"'.I Rechercher dans ’D projectsy2, 10 v] @

n Project managet
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3 Manifest_ISEE

[C3 Manifest_POLDER.

@ exp_MASA_FSA_CNES_Test_Data_Fxchange_01.epp
@ exp_MASA_ESA_TMES_Test_Data_Exchange_DZ2.epp
E| exp_POLDER-Multi-L1GE, epp

B exp_POLDER.epp

Mom de Fichier |exp_F‘OLDER.epp |

Fichiers du type : [F‘.ﬁ.IS project (*.epp) v]

[ Impart ] [.ﬁ.nnuler ]
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6.2 OPENING THE PROJECT

Select the project, right-click the mouse (to display the contextual menu) and click on “Open the project...” or
double-click on the project.

E PAIS prototype =101 x|
File  Edit ‘Window  Help
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<= Project manager \".

open the project...
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¥ Delete SuppHmer

Properties Alt-Entrée
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By default, the project is in design mode. The various nodes can be edited and modified.
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6.2.1 Editing a descriptor

For accessing to the XML Editor, select a descriptor, right-click the mouse (to display the contextual menu) and

click on “Edit descriptor...”.
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6.3 RECEIVING XFDU FILES AND VALIDATING

6.3.1 Switching to transfer mode

On the main project tab, the following two types of icons show the project status, i.e. in design mode (at left) and in
transfer mode (at right):

On the “MOT editor” tab, right-click the mouse (to display the contextual menu) and then click on “Switch to transfer
mode ...". The project then becomes:

PAIS prototype — |EI|5|
File Edit ‘Window Help

=11

< Project manager % Transfer monitaring (POLDER ) ‘lt

& TransFer moritoring (POLDER]

¢/= W 3¢ uloxw [ufn [&[a]a] RIE R (al (2]
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6.3.2 Placing XFDU files in the “reception” directory

To simulate the XFDU file’s arrival in the archive (from the producer), copy one or several “.zip” files from the

“PAIS_DATA\examples\projects \Manifest POLDER\tc3-polder-test-results” directory into the “PAIS_DATA\projects
\POLDER\xfdu\reception” directory.

Dossiers

X

19/03/15 18:03
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6.3.3 Launching the acquisition

On the “Transfer monitoring” tab, right-click the mouse (to display the contextual menu) and then click on “Launch
XDFU reception/validation...”.

PAIS prototype
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At the end of the acquisition, a message appears on the screen indicating the number of SIPs treated and those
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Info

- SIPs treated : 5

L

SIPs errar i 0

——

rejected due to error, if any:

If all of the SIPs are correct, the “transfer object” reception counters are updated.
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6.3.4 Check the invalid SIP files and associated reports.

If SIPs are invalid during the acquisition, the error messages can be checked from the “Transfer monitoring” tab by
right-clicking the mouse (to display the contextual menu) and then clicking on “Show invalid XFDU ...".
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File Edt ‘Window Help
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CDPP WIND use case

Double-click on the file that you want to view.
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AIS prototype
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WIND CDPP use case
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In the XFDU display window, the associated errors are displayed in the lower section.

QXmWiewer: C:\PAIS_DATAprojects¥2.6\ cdpp-wind'\xfdu'invalid\cdpp_wind_xfdu 0008 err.xml ;|g|5|
0= <xfdu:contentlnit ID="tocl"> -
31E <EMLEnsiomns ]
32 <zip:sipTransferlbijectGroup-

33 <groupTypeID=GLls fgroupTypeIDs-

34 <groupInstancelanexGroupe 1</groupInstancelanes

35 </3ip:sipTransferibjectiroups

36 < /extensions:

3THE <Hfduicontentlnit ID="dol">

i=) =] Lextensiorns-

3ag <zip:ziphatalbiects-

40 <datalbjectTypelIl>=THR_LZ DATA /datalbjectTypeIls —

41 </sipisiphatalbjects

4z < /extension-

43 <datalbjectPointer datalbjectID="datalbjectl™ >

44 < fwEdu: contentlnits

453 <xfdu:contentlnit ID="doz">

46 H Lextensiorns

473 <gip:sipbatalbijects>

45 <datalbjectTypell:=TNE_LZ CAT</datalbjectTypell- —

49 </sipisiphatalbjects

50 < fextensions

51 <datalbjectPointer datalbjectID="datalbject2" >

52 <fuidu: contentimits

53 </wfdu: contentlUnits

54 “/fdu: contentnitce =

4] ; [ I

dataFormat - Ervor 12 Invalid mime tvpe "applicationftxt' § et fxml' For data object id 'datadbject’, {waves_tnr_I2)

sequenceCaonstraint - Error 7 1 Sequencing error For "SIP-TYPE-02-DATA-DESCRIPTION' with group '"SROUP_02'  {waves_tnr_|2)
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6.3.5 Viewing control errors on a given descriptor

Select a descriptor, right-click the mouse (to display the contextual menu) and click on “Show errors...”.

File Edit ‘wWindow Help

% El

- Projeck manager © % MOT editor {cdpp-wind) "'.

10T editor {cdpp-wind)

¢/= 2lel mlo(xw [mw [A]a]a] H

W
[u]
A F

o

I

Edit

Remove

Insert

19/03/15 18:03



AKKA IS SGDS-MI-5230-1330-SI
PAIS Iss.: 02 Date: 06/03/2015
Rev.: 00 Date: 06/03/2015
Reference: SGDS-MI-5230-1330-SI Page: 39

Double-click on the error to show the XFDU file that caused the error.
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Error & @ out of range [1..1] sip = 'cdpp-wind-sip-0005" from ‘cdpp_wind _xFdu_0005, xml*
Error 9 : Missing data [1..1] for data object bype 'TMR_LZ_EAST'.  sip = 'cdpp-wind-sip-000&' From ‘cdpp_wind _xfdu_000&, xml’

i
[

CDPP WIND use case

6.3.6 Checking controls carried out on SIPs during acquisition

The controls carried out during SIP acquisition can be shown in a “pais_historic.log” file associated with the project
in the “PAIS_DATA\projects \POLDER\logs” directory.

This file can also be viewed on the prototype monitor launched during start-up. See the section on _Journalisation.

19/03/15 18:03



AKKA IS SGDS-MI-5230-1330-SI
PAIS Iss.: 02 Date: 06/03/2015
Rev.: 00 Date: 06/03/2015
Reference: SGDS-MI-5230-1330-SI Page: 40

6.3.7 Resetting the test set

Within the prototype framework, in order to replay a scenario, it is possible to reset the reception of all SIPs for the
project in progress. This also reinitializes all errors and associated counters. To implement a reset, right-click the
mouse (to display the contextual menu) and click on “Delete SIPs”.

PAIS prototype =10 x|
File  Edit ‘Window  Help
<= Project manager * %® Transfer monitoring (POLDER) \'.
&= W [oe mie/xw [nfn [ala]al [EE]EE [« (5]
111

Swikch to definition mode

Launch #FDU receptionvalidation \
Showe Tnealid XFDU !

Refresh

Hide/Show association

Prink
1f*

6.4 LOGGING

Each project has its own “pais_historic.log” treatment log in the logs directory. This file contains all of the operations
carried out on this project since its creation.

Messages are logged in the following manner:
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<DATE> <[LEVEL]> <[MODULE]> <MESSAGE>

e.g.

2008-08-22 10:17:14 [INFO] [RECEIVER] Initialized
2008-08-22 10:17:14 [INFO] [RECEIVER] started

2008-08-22 10:17:14 [INFO] [RECEIVER] entry = cdpp wind xfdu 0002.xml

2008-08-22 10:17:14 [INFO] [CONTROL] projectId = cdpp-wind

2008-08-22 10:17:14 [INFO] [CONTROL] CU = waves_ documentation cu, TO = cdpp-wind-
transfer-object-0002

2008-08-22 10:17:14 [INFO] [CONTROL] descriptorId

2008-08-22 10:17:14 [INFO] [CONTROL] groupConstraint

2008-08-22 10:17:14 [ERROR] [CONTROL] waves documentation : ERROR 3 'Type of the sip
'SIP-TYPE-ERROR' unknown'

2008-08-22 10:17:14
2008-08-22 10:17:15

2008-08-22 10:17:14 [INFO] [CONTROL] globalOccurrencies
2008-08-22 10:17:14 [INFO] [CONTROL] sipOccurrencies
2008-08-22 10:17:14 [INFO] [CONTROL] dataOccurrencies

] [CONTROL] dataFormat

110

[

[
2008-08-22 10:17:14 [INFO

[ CONTROL] sequenceConstraint

[ERROR] [RECEIVER] treated = cdpp wind xfdu 0002.xml
2008-08-22 10:17:17 [INFO] [RECEIVER] entry = cdpp wind xfdu 0020.xml
2008-08-22 10:17:17 [INFO] [CONTROL] projectId = cdpp-wind
2008-08-22 10:17:17 [INFO] [CONTROL] CU = waves_ documentation cu, TO = cdpp-wind-
transfer-object-0020

2008-08-22 10:17:17 [INFO CONTROL] descriptorId
2008-08-22 10:17:17 [INFO CONTROL] groupConstraint
2008-08-22 10:17:17 [INFO CONTROL] globalOccurrencies
2008-08-22 10:17:17 [INFO

]
]
]
CONTROL] sipOccurrencies
]
]
]

—

[ ]
[ ]
[ ]
[ ]
2008-08-22 10:17:17 [INFO]
[ ]
[ ]
[ ]

CONTROL] dataOccurrencies
2008-08-22 10:17:17 [INFO CONTROL] dataFormat
2008-08-22 10:17:17 [INFO CONTROL] sequenceConstraint
2008-08-22 10:17:17 [INFO RECEIVER] treated = cdpp wind xfdu 0020.xml

2008-08-25 12:49:40 [INFO] [RECEIVER] stopped

The LEVEL indicates whether an error occurred during processing of the XFDU. The error occurring during a
control is repeated as a general error for the XFDU received.

The MODULE specifies the source of the error: CONTROL for an error on a specific control or RECEIVER for a
general error.
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6.4.1 Configuring the error and log output (log4j.xml)

The error output can be parameterized differently using the “log4j.xml” configuration file found in the executable
installation directory. The application needs to be restarted to take the change into account.

The error output (for errors other than XFDU processing errors) is logged in the “pais.log” file in the application
installation directory. To display these errors on the console (standard output and no more pais.log), edit the
“log4j.xml” file and then replace the value “rolling” with “stdout” under the "com.cnes.pais" logger:

<!-- level value = (fatal, error, warn, info, debug, trace, all, off) -->
<logger name="com. cnes.pais" additivity="false">

<level value="info"/>
<appender-ref ref="rol11ing"/>
</logger>

These logs can be viewed using a configurable real-time monitor. To show/hide this MMI monitor at application
start-up, the “log4j.xml” configuration file of the application directory needs to be changed by deleting/inserting the
comments from the “monitor” line under the “pais_historic” logger:

<logger name="pais historic" additivity="false">
<level value="info"/>
<appender-ref ref="historic"/>
<!-- <appender-ref ref="monitor"/> -->
</logger>
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Tue Dec 06 1... [168 INFO [CONTROL] sequenceCoaonstraint
Tue Dec 06 1... 169 IMFO MALIDATION] cdpp-wind-sip-0012
;TUBDBCDE1“.1TD IMFO [ALIDATION] Checksum MDE Ol
Tue Dec 061 (171 ERROR [WALIDATION] Data Checker errar for file:R2000116.00°
Tue Dec 06 1. |172 ERROR [ALIDATION] Data Object errar 'dataCbject’
Tue Dec061.. (173 ERROR [FECEIWER] Praject = cdpp-windProducer = LESIASID = cdpp-wind-5ip-0012type = SIP-..
Tue Dec 061 [174 ERRCOR [RECEWER] treated = cdpp_wind_xddu_0012_errxml
EETUEDECDG1“.1T5 IMNFQ Disconnected database ipaig, jdbc:postaresglilocalhost 54 32/PAIS)
;TUEDECDE1“.1?E INFO [RECEIVER] SIPs treated : 11 (11 SIPs erron
Tue Dec 06 1... (177 IMFO [RECEIVER] stopped

H i
|Producer = LE3TA =
zip = cdpp-wind-sip-0012

type = JIP-TYPE-0Z-DATA-DEICRIFTION

sip origin = cdpp_wind xfdu 001Z_err.xml

|sequence = 12

Wersion = 1.0

CU : waves east_description cu [ textInfo='EAST description' |

. descriptorld = waves_east description

CU : waves_tnr_lZ_cat_schem cu | textInfo='TNR L2 catalog schema' |

. descriptorld = waves_tnr_lZ cat schem

{0 : datadhjectl []

. [CCEDO0LO0] (chk='[MD5] e999720bb3c0d9362Ef1c0ba2bbeta3s59" ), [URL] 'file:easts/native_nl.eas'
(D0 : datalbhjectz []

. [applicationfoctet-stream] (chk='[EAZT] east/native_nZ.eas'), [URL] 'file:RZ00011a4.00°
Location: Com. cnes.pals.receiver. Receiverlanager. launch (ReceiverManager. java: 698)

Throwm:

4] Il 1
Displaying: 177 records out of a total of: 177 records.

For further information on configuring Log4j.xml, see the documentation available on this website:
http://logging.apache.org/log4j/
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7/ POSSIBLE ERROR MESSAGES DURING PROCESSING

General Error Message Comments

- Control error There is an error in the Control. See the
associated message for further information.

- packageHeader missing The SIP heading is missing.

- informationPackageMap missing The SIP’s general information block is missing.

Error Message Comments

1 Bad descriptor Id The descriptor identifier does not belong to the
model.

2 out of range [{?}..{?}] The number of descriptors exceeds the limits
declared in the model.

3 Type of the sip "{?}" unknown The SIP type is not known in this model.

4 This descriptor does not exist in this Sip | The descriptor identifier does not belong to the

Content Type "{?}" group type declared for this SIP
5 This descriptor is missing in this Sip The descriptor identifier is missing in the group
Content Type "{?}" type declared for this SIP

6 out of range [{?}..{?}] The number of SIPs received exceeds the limits
declared for this type of SIP group

7 Sequencing error for "{?}" with group Non-compliance with the reception sequence for

{2} the SIP types.

8 out of range [{?}..{?}] for data object The number of objects for the descriptor exceeds

type "{?}" the limits declared in the model.

9 out of range [{?}..{?}] for group id "{?}" | The number of objects for the group does not
match the expected number declared in the
model

10 Data object type "{?}" unknown The type of object is not known in this model

11 Data object pointer "{?}" is not a valid The descriptor refers to an object that does not

reference exist in this SIP.

12 Invalid mime type "{?}" / "{?}" for data The object’s mime type is not known.

object id "{?}"
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13 Bad group Id “{?}" for data The group identifier does not belong to this
model.
14 Descriptor id different between transfer | The descriptor identifier is invalid.
object id “{?}” and “{?}
15 Descriptor id “{?}” to replace not found | Invalid descriptor identifier to be replaced
for transfer object id “{?}"
16 Data validation Error during data validation
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